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About this document

Scope and purpose 

This user guide provides an overview of the evaluation board EVAL-M1-05F310R including its main features, key 

data, pin assignments and mechanical dimensions. 

EVAL-M1-05F310R is a power evaluation board from the modular application design kit including M1 connector, 

which is the iMOTIONTM standard interface, and three CIPOS™ Nano 100 V half-bridge modules for motor drive 

applications. In combination with either EVAL-M1-101T or other control boards with M1 connector compatible, 

it features and demonstrates Infineon’s CIPOS™ Nano IPM technology for motor drives. 

The evaluation board EVAL-M1-05F310R was developed to support customers during their first steps designing 

applications with IRSM005-301MH CIPOS™ Nano power modules. 

Intended audience 

This user guide is intended for all technical specialists who know motor control, middle- and low-power 

electronics converters. The board is intended to be used under laboratory conditions. 

Evaluation Board 

This board will be used during design in, for evaluation and measurement of characteristics, and proof of data 

sheet specifications.  

Note: PCB and auxiliary circuits are NOT optimized for final customer design. 
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Important notice 

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board 

(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration, 

reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).  

Environmental conditions have been considered in the design of the Evaluation Boards and Reference 

Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards 

has been tested by Infineon Technologies only as described in this document. The design is not qualified 

in terms of safety requirements, manufacturing and operation over the entire operating temperature 

range or lifetime. 

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional 

testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the 

same procedures as regular products regarding returned material analysis (RMA), process change 

notification (PCN) and product discontinuation (PD). 

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for 

evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. 

The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards 

(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other 

requirements of the country in which they are operated by the customer. The customer shall ensure that 

all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant 

requirements and standards of the country in which they are operated. 

The Evaluation Boards and Reference Boards as well as the information provided in this document are 

addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and 

managed according to the terms and conditions set forth in this document and in other related 

documentation supplied with the respective Evaluation Board or Reference Board.  

It is the responsibility of the customer’s technical departments to evaluate the suitability of the 

Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness 

and correctness of the information provided in this document with respect to such application. 

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not 

cause any harm to persons or third party property.  

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" 

and Infineon Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or 

for merchantability.  

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation 

Boards and Reference Boards and/or from any information provided in this document. The customer is 

obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or 

damages arising out of or resulting from any use thereof. 

Infineon Technologies reserves the right to modify this document and/or any information provided 

herein at any time without further notice. 
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

Warning: The DC link potential of this board is up to 100 VDC. When measuring voltage 

waveforms by oscilloscope, high voltage differential probes must be used. Failure to do 

so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take 

time to discharge after removal of the main supply. Before working on the drive 

system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to 

do so may result in personal injury or death. Darkened display LEDs are not an 

indication that capacitors have discharged to safe voltage levels. 

Warning: The evaluation or reference board is connected to the grid input during 

testing. Hence, high-voltage differential probes must be used when measuring voltage 

waveforms by oscilloscope. Failure to do so may result in personal injury or death. 

Darkened display LEDs are not an indication that capacitors have discharged to safe 

voltage levels. 

Warning: Remove or disconnect power from the drive before you disconnect or 

reconnect wires, or perform maintenance work. Wait five minutes after removing 

power to discharge the bus capacitors. Do not attempt to service the drive until the bus 

capacitors have discharged to zero. Failure to do so may result in personal injury or 

death. 

Caution: The heat sink and device surfaces of the evaluation or reference board may 

become hot during testing. Hence, necessary precautions are required while handling 

the board. Failure to comply may cause injury. 

Caution: Only personnel familiar with the drive, power electronics and associated 

machinery should plan, install, commission and subsequently service the system. 

Failure to comply may result in personal injury and/or equipment damage. 

Caution: The evaluation or reference board contains parts and assemblies sensitive to 

electrostatic discharge (ESD). Electrostatic control precautions are required when 

installing, testing, servicing or repairing the assembly. Component damage may result 

if ESD control procedures are not followed. If you are not familiar with electrostatic 

control procedures, refer to the applicable ESD protection handbooks and guidelines. 

Caution: A drive that is incorrectly applied or installed can lead to component damage 

or reduction in product lifetime. Wiring or application errors such as undersizing the 

motor, supplying an incorrect or inadequate AC supply, or excessive ambient 

temperatures may result in system malfunction. 

Caution: The evaluation or reference board is shipped with packing materials that 

need to be removed prior to installation. Failure to remove all packing materials that 

are unnecessary for system installation may result in overheating or abnormal 

operating conditions. 
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1 The board at a glance 

The EVAL-M1-05F310R evaluation board is a part of the iMOTION™ MADK for motor control (iMOTION™ MADK). 

The MADK platform is intended for use in various power stages with different control boards. These boards can 

easily be interfaced through the 20-pin iMOTION™ MADK - M1 interface connector. 

This evaluation board is designed to give comprehensible solutions for the power section featuring by CIPOS™ 

Nano. It provides a DC input and 3-phase output for power. It contains a single shunt for current sensing and a 

voltage divider for DC-link voltage measurement. 

The EVAL-M1-05F310R evaluation board is available from Infineon. The features of this board are described in 

the design feature chapter of this document (UG-2020-24), whereas the remaining paragraphs provide 

information to enable the customers to copy, modify and qualify the design for production according to their 

own specific requirements. 

Environmental conditions were considered in the design of the EVAL-M1-05F310R. The design was tested as 

described in this document but not qualified in term of safety requirements or manufacturing and operation 

over the whole operating temperature range or lifetime. The boards provided by Infineon are subject to 

functional testing only. 

1.1 Delivery content 

The EVAL-M1-05F310R evaluation board is designed to provide an ease-of-use power stage based on the 

Infineon's CIPOS™ Nano intelligent power module (IRSM005-301MH).  

The delivery includes the finished board as shown in Figure 1 and Figure 2. It provides a 3-phase AC connector, 

an EMI filter and soft power-up circuit, input rectifier, DC bus capacitors and 3-phase output for connecting the 

motor. 

It also CoolSETTM based aux power supply to provide 15V and 3.3 V, a single shunt for current sensing and over-

current protection, and a voltage divider for DC-link voltage measurement. The board shown here can be 

operated directly with the required power supply without the need for additional components. 

1.2 Block diagram 

The block diagram of EVAL-M1-05F310R is depicted in Figure 1. 

Figure 1 The block diagram of EVAL-M1-05F310R 
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Figure 2 points out the functional groups on the top side of the EVAL-M1-05F310R design. 

Figure 2 Functional groups of the EVAL-M1-05F310E reference design 

1.3 Main features 

EVAL-M1-05F310R is a complete power evaluation board including 3 half bridge IPMs for motor drive 

application. The kit demonstrates Infineon’s IPM technology for motor drives. Main features of CIPOS™ Nano 

intelligent power module IRSM005-301MH include: 

 MOSFET drain-to-source voltage 100 V 

 Maximum DC current at 25°C case temperature ID = 30 A 

 Package with low thermal resistance and minimal parasitic inductance 

 Independent gate driver in phase with logic input 

 Gate driver supply is 15 V 

 3.3 V logic input compatible 

 Undervoltage lockout protection inside the driver  

 Exposed driver outputs and HEXFET gate terminals for dv/dt setting via a resistor. 

1.4 Board parameters and technical data 

Table 2 depicts the important specification of the evaluation board EVAL-M1-05G310R: 
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Table 2 EVAL-M1-05F310R specifications 

Parameter Symbol Conditions Value Unit 

Input 

Input voltage VDC Lower DC input, less motor power output. 30~72 V 

Input current IDC(maxi) Input DC48 V, output 320 W, Ta=25°C. 6.7 A 

Output 

Power (3-phase) Pout(maxi) At 48 VDC, FPWM=9 kHz, Ta=25°C, Tcase= 100°C 

without heat sink. 

320 W 

Current per phase Iout(maxi) At 48 VDC, FPWM=9 kHz, Ta=25°C, Tcase= 100°C 

without heat sink. 

6.5 A 

DC bus voltage 

Maximum DC bus voltage VDC(maxi) 72 V 

Minimum DC bus voltage VDC(min) Aux power supply’s brown-in voltage. 30 V 

Current feedback 

Shunt resistance R16 Inverter current sensing resistor. 5 mΩ 

Protections 

Output current trip level Itrip Level set by external comparator circuit. 27 A 

Case temperature trip 

level 

TC Users need to consider the temperature gap by 

NTC sensor, it is recommend to set at 100°C or 

less. 

100 °C 

Auxiliary power supply  15 V 

Output voltage Vout1 Used for IPM. 15 ± 5% V 

Output current Iout1 Maximum output current. 100 mA 

Auxiliary power supply  3.3 V 

Output voltage Vout2 Used for IMC controller and protection circuits. 3.3 ± 5% V 

Output current Iout2 Maximum output current. 150 mA 

PCB characteristics 

Dimension Length × width × height (including PCB pillar) 91 × 69 × 33 mm 

Material FR4, 1.6 mm thickness, 2 oz. PCB 2 layers 

System environment 

Ambient temperature Ta Non-condensing, maximum RH of 75% 0~50 °C 

Note: For iMOTION™ IC IMCxxx, there are three types of Gatekill input source options in MCEWizard setup: 

Gatekill-pin, Comparator and Both.  If you select “comparator” mode, the external Gatekill signal 

will be not used, and the signal I_Shunt will be compared by the internal comparator with the 

“Device over-current trigger level setting” value set in MCEWizard. 
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2 System and functional description 

2.1 Getting started with EVAL-M1-05F310R 

In order to run the motor system, a combination of the iMOTION™ MADK power board (EVAL-M1-05F310R) and 

the matching MADK control board (EVAL-M1-101T or other control board) are required. This chapter provides 

more details on setting up the system and getting started with the iMOTION™ MADK development platform. 

The EVAL-M1-05F310R reference designs are tested with EVAL-M1-101T controller boards, which shipped with 

embedded firmware and default parameters. 

Figure 3 shows the basic system connection using EVAL-M1-05F310R to run a motor with MCEDesigner. 

Figure 3 System connection example 

2.1.1 iMOTION™ control board 

1. If you want to use the Infineon control board, please go to the Infineon website, www.infineon.com/MADK, 

and order EVAL-M1-101T. 

2. Then get the latest “IMC101T-T038 MCE Software Package” available on the website, 

http://www.infineon.com/imotion-software. 

3. After you have obtained the control board and software, you are ready to connect your PC to EVAL-M1-101T 

via USB cable, and to program and tune the control board. 

4. Connect EVAL-M1-101T’s M1 20-pin interface connector (J2) to power board (for example EVAL-M1-05F310R, 

see Figure 3).  

5. Use MCEWizard to enter the target motor’s system and operating parameters, as well as the evaluation 

board’s hardware parameters, which will then be used to calculate the controller’s set digital parameters 

representing the complete motor drive system. First click the “Calculate” button on the “Verify & Save Page” 

and then save the drive parameter set into your project directory by clicking “Export to Designer file (.txt)”. 

The saved drive system parameter file will be later used by the MCEDesigner. Refer to Chapter 2.1.3 or 

MCEWizard user guide for more details. 

6. Connect motor phase outputs to the motor. 

7. Connect DC power to power input connector and power-on system. 

8. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC101T-T038 controller 

(IMC101T_Vxxx.irc) by clicking “File” > “Open”. IMC101T_Vxxx.irc file is included in the “IMC101T-T038 MCE 

Software Package” downloaded in step 2. 
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9. MCEDesigner should automatically connect to the EVAL-M1-101T control board using default COM port 

(indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it 

cannot establish the connection, change the COM port as follows: (“System” window active) > Preferences > 

Connection > Connect using (select one of the other available COM ports from the drop-down menu). 

10. Use the following steps to program the system parameters into the internal SRAM of iMOTION™ IC: Click 

“Tools” > “Programmer” and select “Program Parameters.” Browse and select the System Drive 

Parameters .txt file created in step 5. See Chapter 2.1.3 for more details. 

11. Start the motor by clicking the green traffic light button in the control bar. 

12. Stop the motor by clicking the red traffic light button in the control bar. 

2.1.2 iMOTION™ development tools and software 

The iMOTION™ development tool installers for MCEDesigner and MCEWizard are available for download via 

Infineon iMOTIONTM website (http://www.infineon.com/imotion-software). All supported tools and software 

variants are listed there. Please visit this page periodically to check for tool/software updates. 

The isolated on-board debugger provides the USB-to-UART bridge between the PC and the target iMOTION™ 

device with 1 kV DC galvanic isolation between the motor drive system (hot side) and the PC/debugger (cold) 

side.  The on-board debugger uses the SEGGER J-Link driver for UART communication with IMC101T-T038. The 

J-Link driver will be installed during the MCEDesigner installation. In case the driver is not installed properly, 

please go to the SEGGER J-Link website to download and install the latest J-Link “Software and Documentation 

pack for Windows.” 

2.1.3 MCEWizard setup overview 

Double-click the shortcut to open the MCEWizard and configure the parameters for evaluation boards or motor. 

Figure 4 shows the “Welcome Page” for MCEWizard, where the MADK control board or power board can be 

selected from the pull-down list. Infineon continues to release new MADK controller and power boards. 

Therefore, it is possible that some of the latest power boards have not been pre-configured in the MCEWizard 

tool and cannot be selected from the pull-down menu. In that case, the user should select another power board 

(as similar as possible) and follow the MCEWizard setup steps by entering the parameter values that are specific 

to the chosen board. Make sure both “I have modified the circuit board” and “Enable advanced question” 

checkmarks are selected. Please refer to the Application Note of the corresponding power board for additional 

information.  

After selecting the MADK control and the power board, start the MCEWizard system setup procedure by clicking 

the “Next” button in the right bottom corner as shown in Figure 4. 
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Figure 4 Welcome page of MCEWizard 

The iMOTION™ MADK system enables users to easily test different combinations of control and power boards 

with their motors. Users should be familiar with the system level parameters that are related to the motor used. 

There is a very limited number of parameters which are specific to the control board or power board hardware. 

Table 3 provides the MCEWizard setup overview for hardware related parameters specific to EVAL-M1-05F310R 

power board. Similar tables will be available in each control board’s Application Note. A combination of this 

table and the corresponding table of the control board provides sufficient information to set up the MADK-

based motor drive system rapidly. 

Table 3 MCEWizard setup overview table 

Parameter Value

Control board selecting EVAL-M1-101T for example 

Power board selecting EVAL-M1-05F310R

Motor 1 shunt configuration Single shunt 

Controller supply voltage +3.3 V 

Max DC bus voltage 80 V 

DC bus sensing high resistor 1020 kΩ 

DC bus sensing low side resistor Refer to the control board user manual 

NTC temperature shutdown value Refer to the control board user manual 

Gate sense low-side devices High is true 

Gate sense high-side devices High is true 

Motor 1 current input Calculated in the corresponding section in control board user manual 
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After all the MCEWizard questions are answered, the “Verify & Save Page” will be shown as in Figure 5. 

Figure 5 Verify and save page of the MCEWizard 

Click “Calculate Parameters” button and “Export to Designer File (.txt)” button to save the parameter file which 

will be used by the MCEDesigner in the next steps. 

2.1.4 MCEDesigner setup overview 

After installing MCEDesigner, there is a shortcut for the MCEDesigner on Windows desktop. Double-click the 

shortcut to open MCEDesigner and then open “IMC101T_xx.irc” file as shown in Figure 6. 

Figure 6 MCEDesigner’s main display for EVAL-M1-101T 
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Figure 7 “Program IMC controller” pop-up window 

After the drive system parameter file has been programmed into the IMC101 controller, and the motor drive 

system is powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change 

the motor speed, modify drive parameters and many other functions. Please refer to the MCEDesigner 

documentation for more details. 

Note: The on-board debugger section of the EVAL-M1-101T has galvanic isolation from the controller 

section and the attached power board. In order to program the parameters or firmware to the 

IMC101T-T038 controller, the 3.3 V DC voltage needs to be supplied to the controller section of the 

EVAL-M1-101T. This voltage can either be supplied by the power board (MADK power boards are 

designed to supply the 3.3 V to the control board via M1 or M3 connector) or by feeding the 3.3 V 

voltage to the control board via some of the available 3.3 V access/test points if the power board is 

not attached to the EVAL-M1-101T control board.  

To program new firmware and the drive system parameters into IMC101T-T038, please click the “Tools” menu 

and select “Programmer” in the pull-down list.  The pop-up window “Program IMC controller” will show up as 

in Figure 8. Click on the “Program Firmware and Parameter” radio button, and select the “Drive System 

Parameter” file created using MCEWizard by clicking on the “Browse” button on the row of “Program Parameter 

File”, and then select the firmware file by clicking on the “Browse” button in the row of “Program Firmware 

File”. Finally, click on the “Start” button to program the parameter file into the IMC101T-T038 IC. 
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Figure 8 Program firmware and parameter in “Program IMC controller” pop-up window 

2.2 The current waveform form MCEDesigner 

MCEDesigner has a parameter trace function for debugging and checking the PCB layout/parameter settings in 

the “.irc” window. 

Figure 9 Trace function in MCEDesigner window 
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The trace function shows what the MCE ‘saw’. The figures below are the motor current waveform at stop and 

running status. 

Figure 10 Iu and Iv static noise waveform from MCEDesigner 

Figure 11 Iu and Iv waveform from MCEDesigner @ Iu and Iv @ Io=5.7 A, 48 VDC , 24 kHz 

This is typical current waveform of a sinusoidal brushless motor driven by the EVAL-M1-05F310R and EVAL-M1-

101T with iMOTIONTM software. 

2.3 Description of the functional blocks

The motor inverter of EVAL-M1-05F310R evaluation design is implemented by the IRSM005-301MH module, and 

the auxiliary power supply is based on the CoolSETTM: ICE5GR4780AG. 



User guide 15 of 39 V1.0  

2020-11-10 

EVAL-M1-05F310R user guide 
Modular application design kit (MADK) of IRSM005-301MH

System and functional description 

2.3.1 Overview of IRSM005-301MH 

Figure 12 provides the overview of the IRSM005-301MH internal electrical schematics. For further information 

regarding these CIPOS™ Nano such as static and dynamic electrical behavior, as well as thermal and 

mechanical characteristics, please refer to the datasheet of the IRSM005-301MH. 

Figure 12 IRSM005-301MH  internal electrical schematic 

The main features of the CIPOS™ Nano IPM IRSM005-301MH include: 

 MOSFET drain-to-source voltage 100 V 

 Maximum DC current at 25°C case temperature ID = 30 A 

 Package with low thermal resistance and minimal parasitic inductance 

 Independent gate driver in phase with logic input 

 Gate drive supply is 15 V 

 3.3 V logic input compatible 

 Undervoltage lockout protection inside the driver  

 Exposed driver outputs and HEXFET gate terminals for dv/dt setting via a resistor 

Table 4 Absolute maximum ratings of IRSM005-301MH 

Symbol Description Min Max Unit 

VDS MOSFET drain-to-source voltage -- 100 V 

IO Maximum DC current per MOSFET @ TC = 

25°C. 

-- 30 A 

Pd Maximum power dissipation per 

MOSFET @ TC = 100°C. 

-- 13.5 W 

TJ (MOSFET & IC) Operating junction temperature. -- 150 °C 

TS Storage temperature range. -40 150 °C 

VB High side floating supply voltage. -0.3 VS+20 V 
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VS High side floating supply offset voltage. VB-20 VB+0.3 V 

VCC Low side fixed supply voltage. -0.3 20 V 

VIN Low input voltage of LIN, HIN. -0.3 VCC+0.3 V V 

2.3.2 Overview of ICE5GR4780AG 

The ICE5GR4780AG is single power chip that is Infineon’s CoolSETTM, offers high performance, high efficiency 

and easy to use with DC 30~600 V super wide voltage range industrial auxiliary power supply for super buck 

with DC 36 ~ 540 V standard industrial aided design. 

Figure 13 ICE5GR4780AG  internal electrical schematic 

Features 

 Integrated 800 V avalanche rugged CoolMOS™ 

 Enhanced Active Burst Mode with selectable entry and exit standby power to reach the lowest standby 

power <100 mW 

 Digital frequency reduction for better overall system efficiency 

 Fast startup achieved with cascode configuration 

 DCM and CCM operation with slope compensation 

 Frequency jitter and soft gate driving for low EMI 

 Built-in digital soft start 

 Integrated error amplifier to support direct feedback in non-isolated flyback 

 Comprehensive protection with input line over voltage protection, VCC over voltage, VCC under voltage, 

overload/open loop, over temperature 
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 All protections are in auto restart mode 

 Limited charging current for VCC short to GND 
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3 System design 

The EVAL-M1-05F310R board is an optimized design for DC30~72V major home and industry appliances. To 

meet individual customer’s requirements and to make the EVAL-M1-05F310R evaluation design a basis for 

development or modification, all board design data such as schematics, Gerber and Altium design data can be 

found on the Infineon homepage and log in your account to download them. 

3.1 Inverter section using CIPOSTM Nano 

There CIPOSTM Nanoes are used to buildup the inverter section as shown in Figure 14. Three half-bridge 

modules are used as the 3-phase inverter bridge section. Every half-bridge module includes two power 

MOSFETs and one half-bridge gate driver. The shunt resistor section is also given. The three capacitors C4, C5 

and C6 are used as bootstrap capacitors to provide the necessary floating supply voltages VBU, VBV and VBW 

respectively. 

Figure 14 Schematic of the inverter section 

3.2 DC to DC power converter 

Figure 15 depicts the schematic of the super buck for auxiliary power supply available on the EVAL-M1-05F310R 

board. The circuit includes ICE5GR4780AG that is used to generate 15 V (VCC) directly from the DC bus. VCC is 

connect to the gate drivers inside the CIPOS™ Nano. The linear regulator TPS56043XF generates 3.3 V from VCC. 

The 3.3 V power supply is used in the overcurrent comparator circuit. Red LED1 is used to signal whether the 

board is powered or not. Both, VCC and 3.3 V are also present on the 20-pin interface connector J3 to power 

circuitry on the controller board. 

Figure 15 Power supply section 
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Figure 16 U14 (Pin12) output type waveform at 48 V DC input 

3.3 DC bus voltage measurement 

Pin 14 of connector J3 provides access to the DC bus voltage. Three possible feedback cases are associated 

with this pin. 

Figure 17 DC bus sensing 

R48 is the safety resistance on the connection port when the connector is open. The DC bus sensing low side 

resistance is R48//R1 (R1 is the pull-down resistor on EVAL-M1-101T). It is: 

� R��� ���� =
1 MΩ × 13.3 kΩ

1 MΩ + 13.3 kΩ
= 13.13 kΩ
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3.4 Current sensing and amplifying

The current feedback of EVAL-M1-05F310R is single-shunt sensing by R16. It is 5 mΩ. The current output IU+ and 

IU- goes to J3. 

Figure 18 Current sense and signal amplification 

An LPF consists of R20/R23/C14/C15 to remove EMC noise from R16. The current amplifier consists of 

R18/R19/R20/R22/R23/C13 U1A for lower noise and proportional amplifier.  

The gain of the amplifier is: 

G =
�18 + �19 + �20

�19 + �20
= 15.96

The current scaling is: 

V����� = R16 × G = 79.8 mV/A

Static status:  

V� =
R30 × 3.3 V

R26 + R29 + R30
= 0.607 V

The response time: 

T� =
1

GBWP����
A − 1

= 1.5 μs

R21 matches the resistance with U11A output. The GBWP is gain bandwidth of U11.  

3.5 Current feedback to the control board

The circuit below shows the feedback current signal to the control board. The offset circuit consists of R6 and 

3.3 V. 
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Figure 19 Current signal transmission of EVAL-M1-05F310R+EVAL-M1-101T 

The attenuation of the current signal from IU+ to IU: 

α =
R6

R6 + R21 + R27
= 0.833

Total gain to IU input: 

� G = α × G = 13.29

Total current scaling to IU input: 

V������ = R16 × � G = 66.4 mV/A

Figure 20 Current input scaling setup in MCEWizard 

The current offset to IU input: 

Voffset = (3.3 V − 0.6 V) ×
R21 + R27

R6 + R21 + R27
+ 0.6 V = 1.06 V



User guide 22 of 39 V1.0  

2020-11-10 

EVAL-M1-05F310R user guide 
Modular application design kit (MADK) of IRSM005-301MH

System design 

Since the control board of the ADC range is 3.3 V, we have to select the internal gain of control board to “1”. 

Figure 21 Setup current signal gain to “1” 

3.6 OCP, GK and IOCP setup

Figure 22 is the overcurrent protection (OC) and gate kill (GK) circuit. The PWMUH, PWMUL, PWMVH, PWMVL, 

PWMWH, PWMWL are three-phase 3.3 V level PWM from J3 (from EVAL-M1-101T). UH, UL, VH, VL, WH, WL is 3.3 V 

level PWM to U1, U2, U3 (IPM). The following: R51, R52, R54, R55, R56, R57 are input resistors for damping noise 

from connections. R58, R59, R60, R61, R62, R63 are pull-down resistors for preventing noise from input open 

(J3). 

3.6.1 OCP setup on EVAL-M1-05F310R

Figure 22 Overcurrent and GK/PWM shutdown 
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The threshold voltage of the schmid trigger (U11B) is set to: 

V������� =
R35

R32 + R35
× 3.3 V = 1.98 V

The reflected overcurrent threshold: 

I������� =
V����������

V������
= 17.2 A

The response time: 

T� = R25 × C16 = 100 ns

When shunt current is over 17.2 A, U11B pin 7 outputs “0”. 

3.6.2 PWM shutdown and GK output 

U12A is a buffer circuit for the comparator. When overcurrent occurs, U11B pin 7 outputs “0”, C23 will be fast. A 

logic “0” signal appears on the output of U12B.  This is a shutdown signal for all PWM inputs. This is also a gate- 

kill signal to J3 to inform the control board to stop PWM output. The total delay time of the shutdown is: 

� T� = T� + T� = 1.5μs + 0.1μs = 1.6 μs

When the over current is removed. U11B will go logic “1”. C23 will be changed by R36. The charge time constant 

is: 

T�� = R36 × C23 = 220 μs

For each overcurrent, U12B will output about 220 µs “0” for shutdown PWM and branch control system through 

J3. 

Figure 23 Logic of PWM input/output and DW/GK 
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Figure 24 Waveform of overcurrent and PWM shutdown 

3.6.3 OCP setup in MCEWizard

EVAL-M1-101T has an internal comparator. The default value of the threshold is 1.8 V (corresponding 17 A). 

Figure 25 Overcurrent setup in MCEWizard 

To calculate overcurrent protection threshold for MCEWizard based on EVAL-M1-05F310R board, use the 

formula below to calculate the voltage threshold value based on your selected overcurrent (IOCP). 
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���� = ������� + ������� × ����

= 1.06 V +
66.4 mV/A × I���

1000

Figure 26 Vref vs overcurrent (Iocp) 

3.7 NTC thermistor characteristics and over-heating protection calculation  

EVAL-M1-05F310R has an NTC (R46) to measure Tc for over-temperature protection on top of U2. This 

temperature value is sent to EVAL-M1-101T. The part number is NTC is NXRT 15WF 104FA1B. 

Figure 27 NTC(R50) on EVAL-M1-05F310R and connection to EVAL-M1-101T via J3 

VTH output value vs temperature is shown in Figure 28. MCEWizard type setup is shown in Figure 29. 
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Figure 28 VTH output to EVAL-M1-101T 

Figure 29 NTC temperature shutdown on MCEWizard 
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3.8 Layout 

Figure 30 Top layer 
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Figure 31 Bottom layer 
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Figure 32 Top over layer 
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Figure 33 Bottom over layer 



User guide 31 of 39 V1.0  

2020-11-10 

EVAL-M1-05F310R user guide 
Modular application design kit (MADK) of IRSM005-301MH

System design 

3.9 Bill of material  

The complete bill of material is available on the download section of the Infineon homepage. A log-in is 

required to download this material. Table 5 is key components for this board. 

Table 5 BOM of the most important/critical parts of  EVAL-M1-05F310R 

S. No. Ref Designator Description Manufacturer Manufacturer P/N 

1 U1, U2, U3 CIPOSTM Nano Infineon IRSM005-301MH 

2 U14 CoolSETTM Infineon ICE5GR4780AG 

3 D1, D2, D3, D7, D8, 

D9, D10, D11 

Diode 
Infineon BAS3005A-02V 

4 C1, C2 Electrolytic 

capacitor 

Wurth Elektronik 860240981008 

5 L1 Magnetic-core 

inductor 
Wurth Elektronik 744731102 

6 L2 Magnetic-core 

inductor 
Wurth Elektronik 74479777310A 

7 R16 Shunt resistance  5 mΩ 

8 R50 NPT NXRT-5WF-100k 1% 

3.10 Connector details 

General information about the connectors of the EVAL-M1-05F310R evaluation board is provided in the tables 

below. Table 6 includes details of the DC input connector J1. Table 7 provides details of the motor side 

connector J2. Table 8 provides the pin assignments of the iMOTION™ MADK-M1 20-pin interface connector J3. 

This connector is the interface to the control board. 

Table 6 J1 – DC input connector 

Pin Name Details 

1 DC+ DC+ connection 

2 DC- DC- connection 

Table 7 J2- Motor side connector 

Pin Name Details 

1 U Connect to motor phase U 

2 V Connect to motor phase V 

3 W Connect  to motor phase W 

Table 8 J3- iMOTION™ MADK-M1 20-pin interface connector to the control board 

Pin Name Description 

1 PWMUH 3.3 V compatible logic input for high side gate driver-phase U 

2 GND Ground 

3 PWMUL 3.3 V compatible logic input for low side gate driver-phase U 

4 GND Ground 

5 PWMVH 3.3 V compatible logic input for high side gate driver-phase V 
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Pin Name Description 

6 +3.3V 3.3 V power supply  

7 PWMVL 3.3 V compatible logic input for low side gate driver-phase V 

8 +3.3V 3.3 V power supply  

9 PWMWH 3.3 V compatible logic input for high side gate driver-phase W 

10 IU+ Shunt voltage+ 

11 PWMWL 3.3 V compatible logic input for low side gate driver-phase W 

12 IU- Ground  

13 GK Gatekill  

14 DCBSENSE Input, DC bus voltage to AIN1 after 2Mohm registers  

15 VTH Input, voltage input of power module’s temperature sense  

16 IV+ OPEN 

17 IV- OPEN 

18 IW+ OPEN 

19 IW- OPEN 

20 VCC Defined for 15 V power supply  
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4 System performance

4.1 Type working waveform at DC 48 V input

Figure 34 IRSM005-301MH gate drive  

Figure 35 IRSM005-301MH PWM power output 
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Figure 36 IU output current @ DC 48 V, FPWM = 12 kHz 

This is a typical sinusoidal current waveform of a brushless motor from the EVAL-M1-05F310R + EVAL-M1-101T 

with iMOTIONTM software. 

4.2 Tcmaxi vs Iout at different PWM frequencies

Figure 37 IRSM005F301MH case temperature vs output current with different PWM frequency (at 48 

VDC, Ta=25℃) 
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4.3 Options for cooling 

EVAL-M1-05F310R has three cooling options for easy configuration and extending to higher power applications. 

1. Self-cooling (default) 

2. Heat-sink cooling 

3. Fan cooling 

4.3.1 Self-cooling 

IRSM005-301MH is the double-sided cooling on the PCB done by copper and vias. For 0~6.2 A loading (input: DC 

48 V, fPWM=9 kHz, Ta=25℃, Tc≤100℃), the EVAL-M1-05F310R can operate well with PCB copper heat 

dissipation, and does not need an additional heat sink. 

Figure 38 IRSM005-301MH heat conduction and cooling by two layers PCB copper 

4.3.2 Heat-sink cooling 

Figure 39 White lined square of installed heat sink 
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This evaluation board reserves space for mounting an additional heat sink to extend output power. Figure 16 

shows how to mount the heat sink. Please note the isolation thermal pad is required to isolate the PCB circuit 

to heat sink. 

Figure 40 Instruction for heat sink installation 

Note:

1. Heat sink size: ≤  50 mm(L)×50 mm(W)  

2. Insulating thermal pad:  ≥  50 mm× 50 mm× 0.5 mm 

3. Remove test point: CS+, CS- 

4. Screw： M3×10 

4.3.3 Fan cooling 

Whether in self-cooling or heat sink mode, EVAL-M1-05F310R supports additional fan cooling.  

In the fan cooling mode, please set up Tc limited lower than 85°C so as not to overheat the MOSFET. 
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5 References and appendices 

5.1 Abbreviations and definitions 

Table 9 Abbreviations 

Abbreviation Meaning 

MADK Modular application design kit 

OPA Operational amplifier 

LPF Low-pass filter 

SPWM Sinusoidal pulse width modulation 

CE Conformité Européenne 

EMI Electromagnetic interference 

UL Underwriters Laboratories 

5.2 References 

[1] Infineon Technologies AG. Datasheet of Infineon IPM IRSM005-301MH Datasheet (2020), V2.3 

www.infineon.com

[2] Infineon Technologies AG. Datasheet of Infineon IMC101T Datasheet (2020). V1.6 www.infineon.com. 

5.3 Additional information  

The power board is now available for customers in small order quantities. In order to initiate the testing, 

customers are advised to order the following items: 

Table 10 Ordering information 

Part number Symbol Package Quantity

EVAL-M1-05F310R  Boxed 1 

IRSM005-301MH U1, U2, U3 IFX-PQFN-7x8 3 

ICE5GR4780AG U14 PG-DSO-12 1 

BAS3005A-02V D1, D2, D3, D7, D8, D9, D10, D11 INF-SC79_V 8 
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